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INTRODUCTION

My name is Ema Dan. I’m a 2nd year student at OCAD University in Toronto, Canada. 

This book documents 4 weeks of my process work for Project #1 in my Graphic Design 1 class, during September and 

October 2017. The project was self-directed, and I ended up making a coloring book.
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PROJECT 1

“Art About Art”

The instruction for this project was basically, “Go document 

a public space in a million ways, then make something with 

what you’ve gathered.” 

I chose to use the Art Gallery of Ontario, also known as the 

AGO, as my inspiration.

At first I had no idea what I was going to make, which was 

kind of the point, but after the first week I had a clear plan 

to create a coloring book — a fancy coloring book, with 

abstract line drawings based on the AGO architecture and 

further filled in with patterns that evoke the feeling of the 

AGO and Frank Gehry’s architecture. And hard covers, 

because I love hard covers. I was really happy to have 

thought of the coloring book idea because I’ve wanted to 

make a coloring book for several years now. Finally I had a 

good reason to make it and great concept to base the line 

drawings on. 

The purpose and intention of the book is to relate and 

propagate the feelings the AGO and art provides — 

calmness, inspiration, beauty, creativity — and carry the 

feelings to other people when they color. My classmates and 

I joked that it would be “Art Inception” because I use art 

(the architecture), to create art (photos), which I turn into 

art (line drawings), and fill them in with art (patterns), in 

order to design art (page layouts reminiscent of paintings 

on walls), to create a collection of art (the book), so that 

people may color it in and create more art (their colored 

art)! All in the spirit of art itself: inspiration and creativity!

The coloring book is called “Art About Art”.
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” There are several beliefs about what graphic 

design is. Some see it in service to business, 

some as an art form, some as storytelling, some 

in service to human need, and so on… While you 

continue along your undergraduate journey you 

will be exposed to several perspectives as to 

what graphic design is and ultimately you need 

to decide for yourself in order to determine what 

kinds of practice you wish to pay attention to 

and engage in. ... This first project has students 

exploring a procedure from qualitative research 

(a descriptive question matrix from Spradley’s 

Participant Observation) in order to document 

observations made in a public space.

While we are designers, not ethnographers, 

this project is created in the assumption that 

graphic design is a practice grounded in culture: 

design activity is informed by culture(s) while 

simultaneously producing culture(s). James 

Spradley a professor of Anthropology (in 

context to ethnography) states that studying 

culture means dealing with “three fundamental 

aspects of human experience: what people do 

(cultural behaviour), what people know (cultural 

knowledge), and the things people make and use 

(cultural artifacts)” (Participant Observation, 

1980, p.5). 

This stage of the project has you observing and 

documenting a public space. Public space—for 

the purposes of this project—is a space that 

is open to “the” community typically (but 

not always) provided by government and 

not typically a space for commercial use. For 

example: a community centre (basketball court, 

running track, indoor/outdoor), park (dog, 

people, garden), library (do not use OCAD U’s 

library), boardwalks, monuments, etc. 

The outcome will be developed based off of each 

students intent and purpose in communicating 

their chosen space in either a 2- or 3- or 4- 

dimension piece.
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Descriptive question matrix : Spradley, J.  (1980). Participant observation. New York : Holt, Rinehart & Winston.  

 SPACE OBJECT ACT ACTIVITY EVENT TIME ACTOR GOAL FEELINGS 

SPACE 
The physical place 
or places  

Can you 
describe in 

detail all the 
places?  

What are all the 
ways space is 
organized by 

objects?  

What are all the 
ways that space are 

organized by 
actions? 

What are all the 
ways space is 
organized by 

activities? 

What are all the 
ways space is 
organized by 

events? 

What spatial 
changes occur over 

time?  

What are all the 
ways space is 

used by actors?  

What are all the 
ways space is 

related to 
goals? 

What places are 
associated with 

feelings? 

OBJECT  
The physical 
things that are 
present 

Where are 
objects 

located?  

Can you describe 
in detail all the 

objects? ? 

What are all the 
ways objects are 

used in acts? 

What are all the 
ways objects are 

used in 
activities? 

What are all the 
ways objects are 
used in events? 

What are all the 
ways objects are 

used in activities? 

What are all the 
ways objects are 
used by actors? 

How are 
objects used in 
seeking goals?  

What are all the 
ways objects 

evoke feelings? 

ACT  
Single actions that 
people do 
 

What are all 
the places 

acts occur?  

What are all the 
ways acts 

incorporate 
objects?  

Can you describe 
in detail all the 

acts?  

What are all the 
ways that acts are 

involved in 
activities?  

What are all the 
ways that acts are 

involved in 
events?  

How do acts vary at 
different times?  

What are all the 
ways acts 

incorporate 
actors?  

What are all the 
ways acts 

involve goals? 

How do acts 
involve 

feelings? 

ACTIVITY 
A set of related 
acts people do 

What are all 
the places 
activities 
occur?  

What are all the 
ways activities 

incorporate 
objects?  

What are all the 
ways activities 

incorporate acts?  

Can you describe 
in detail all the 

activities?  

What are all the 
ways that 

activities are 
involved in 

events?  

How do activities 
vary at different 

times?  

What are all the 
ways activities 

incorporate 
actors?  

What are all the 
ways activities 
involve goals? 

How do 
activities 
involve 

feelings?? 

EVENT 
A set of related 
activities that 
people carry out  

What are all 
the places 

events 
occur?  

What are all the 
ways events 
incorporate 

objects?  

What are all the 
ways events 

incorporate acts?  

What are all the 
ways events 
incorporate 
activities?  

Can you describe 
in detail all the 

events?  

How do events occur 
over time? Is there an 

order of events?  

What are all the 
ways events 
incorporate 

actors?  

What are all the 
ways events 

involve goals? 

How do events 
involve 

feelings? 

TIME 
The sequencing 
that takes place 
over time  

Where do 
time periods 

occur?  

What are all the 
ways time affects 

objects?  

How do acts fall 
into time 
periods?  

How do activities 
fall into time 

periods?  

How do events 
fall into time 

periods?  

Can you describe in 
detail all the time 

periods?  

When are all the 
times actors are 

"on stage"? 

How are goals 
related to time 

periods? 

When are 
feelings 
evoked? 

ACTOR 
The people 
involved 

Where do 
actors place 

themselves?? 

What are all the 
ways actors use 

objects?  

How are actors 
involved in acts?  

How are actors 
involved in 
activities?  

How are actors 
involved in 

events?  

How do actors 
change over time or 
at different times?  

Can you describe 
in detail all the 

actors?  

Which actors 
are linked to 

which goals?  

What are the 
feelings 

experienced by 
actors?  

GOAL 
The things people 
are trying to 
accomplish 

Where are 
goals sought 

and 
achieved? 

What are all the 
ways goals 

involve use of 
objects?  

What are all the 
ways goals 

involve acts?  

What activities 
are goal seeking 

or linked to 
goals?  

What are all the 
ways goals 

involve events?  

Which goals are 
scheduled for which 

times?  

How do the 
various goals 

affect the various 
actors? 

Can you 
describe in 

detail all the 
goals? 

What are all the 
ways goals 

evoke 
feelings?  

FEELINGS 
The emotions felt 
and expressed 

Where do 
the various 

feeling states 
occur?  

What feelings 
lead to the use of 

what objects?  

What are all the 
ways feelings 
affect acts? 

What are all the 
ways feelings 

affect activities? 

What are all the 
ways feelings 
affect events? 

How are feelings 
related to various 

time periods?  

What are all the 
ways feelings 

involve actors?  

What are the 
ways feelings 

influence 
goals? 

Can you 
describe in 

detail all the 
feelings? 
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point* (dot**) 

 

 

 

line* ** 

 

 

 

plane* ** 

 

 

volUMe* ** 

 

 

 

SHape** 

 

 

 

coloUr** 

 

 

 

diMenSion** 

 

 

ForM** 

 

 

 

 

 

 

teXtUre** 

 

 

Material** 

 

All of the above can have many of these properties as well

no BreadtH, no lengtH,  

a poSition,  a reFerence 

 

 

BoUnd By point, no BreadtH, 

direction,  MoveMent,   

paSSage, tiMe, trajectory 

 

BreadtH, lengtH, iMplieS  

SUrFace, no deptH 

 

coMpriSed oF planeS,  

illUSory 2d 

evidence oF Media/Marking tool: 

FoUnd, grapHite,  ink, paint, piXel, 

etc. 

 

evidence oF Media/Marking tool: 

FoUnd, grapHite,  ink, paint, piXel, 

etc. 

 

FoUnd, illUSory 3d, SHape  

(See Below),  SUrFace   

 

cone, cUBe/cUBoid,  cylinder,  

diMenSion, MaSS, polygon, priSM, 

pyraMid 

 

circle, decagon, Free-ForM,  

HeXagon,  octagon, organic,  

pentagon, SqUare,  triangle  

 

BrigHtneSS, HUe, intenSity,  

local, non-local, pUrity, SatUra-

tion, SHade, tint, tone,  valUe 

 

1/2/3/4-point  perSpective,  

2/3/4-diMenSional, deptH 

 

Made viSiBle (SUcH aS tHe  

conceptUal  eleMentS wHen Made 

tangiBle),  artiFact or conStrUct 

(Book, poSter,  interaction, 

concept), contoUr oF  artiFact 

(illUSory 3d) 

 

illUSory, interFace oF  Media and  

Material, pHySical, viSUal  

 

digital, FoUnd, raw, reFined 

 

angUlar 

craFt (qUality)   

coloUr   

cUrvilinear 

dynaMic 

geoMetric 

ELEMENTS

Components can be reduced   

down into basic elements. 

PROPERTIES OF ELEMENTS*

 conceptUal—point, line, plane, 

and  volume have origins in euclidean  

geometry. They are not visible; when 

they are they are no  longer conceptual.

PROPERTIES OF ELEMENTS**

tangiBle—when point, line,  

plane, and  volume become tangible 

we can further define their visual 

properties. 

PRINCIPLES

Means of organizing elements  

and their relationships.

GESTALT PRINCIPLES

cloSUre 

containMent 

continUity  

groUping 

prägnanz  

proXiMity  

repetition 

SiMilarity 

ACTIONS

The manipulation, disruption,  

or qualification of principles. 

PRACTICES

To further build upon our core  

language we look to other practices  

and their specialized lexicons. 

aSyMMetry/SyMMetry  

attraction/repUltion 

BackgroUnd/ForegroUnd  

Balance/inStaBility  

clarity/aMBigUity 

coMpoSition/StrUctUre 

contraSt/HarMony 

denSity/SparSity  

direction  

doMinance/reServation 

 eMpHaSiS 

gradation  

HierarcHy 

MoveMent 

opaqUeneSS /tranSparency 

poSitive/negative Space 

proportion 

radiation  

repetition 

 rHytHM  

Scale  

Static/active 

 tenSion  

Unity/FragMent 

variation

accelerate 

add 

align 

crop (FraMe) 

diSplace 

diSrUpt 

diStriBUte 

divide 

enlarge 

eXaggerate 

eXtract 

eXtrUde 

FractUre 

interlock 

interSect 

iSolate 

jUXtapoSe 

layer 

Mirror 

ModiFy 

Move 

MUltiply 

neSt 

overlap 

penetrate 

redUce 

reFlect 

SHear 

SHiFt 

Split 

SUBtract 

torqUe 

wave  

cineMatograpHy 

coloUr 

drawing 

interactivity 

Materiality 

pHotograpHy 

typograpHy 

OCAD U Graphic Design September 2015—Version 5

When we talk about our work, and that of our peers, we need  
to share a common ground.  The most direct route to a common  
understanding in any critique is to define, and share,  a core  
vocabulary. Below is the beginning to just such a lexicon (the 

vocabulary and language of a discipline)—by no means compre-
hensive—but more than rudimentary.  The terms below vary little 
across the design disciplines and form a strong base from  which 
to branch out into other, more specialized lexicons.

Curriculum Coordination

linear 

organic  

pHySical/illUSory 

rectilinear 

SHarp 

SoFt 

teXtUre

GRAPHIC DESIGN—
FIRST YEAR  
CORE DESIGN  
VOCABULARY
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PROCESS/THOUGHTS/PLANNING:

In class when we spoke about documenting a space, my first idea was to use Grange
Park because of the natural textures and new landscaping… of course that just had to
be the example we used. :( My next favorite public place is the AGO; I started jotting
down notes with this location in mind. The morning of the day I went, I was having
second thoughts and I almost changed to go use St Patrick Church, St Andrew Church,
or Allan Gardens. I decided to go with my gut and use the AGO, even though I feared
the lack of textures which I love.

I brought diverse drawing materials, charcoal, and tracing paper, but when I arrived it
didn’t feel appropriate for the space to document it this way. I used the list of design
elements from Comm.Des.2/GDES.1016.002 as well as the descriptive question index
from this week to inspire my documentation ideas. I took audio because I wanted to
introduce line and thought I could use the sound waves in a future design. I took video
because I thought I could use frames to document passing time in colors or textures
somehow. I took photos of surfaces and shapes that inspired me for possible future art;
things like perspective, sculptural or picturesque lines, and materials are what I focused
on. I wanted to take more photos of colors as color swatches but they weren’t turning
out well due to lighting. I wanted to work more with hand-made lines so I decided to
document the placements and relative size of a whole floor of paintings to create a
collage of rectangles/lines. The resulting design looks usable for future art in some way.
Also, because I love typography, I needed words to use, so I surveyed 80 people for
descriptive words of the AGO—this was my favorite documentation process because it
doesn’t just reflect my singular perspective. It’s also fun as an antithesis to “a picture is
worth a thousand words”, more like “a word is worth a thousand pictures”, which seems
appropriate for documenting an art gallery. Following the theme of word associations, I
asked myself something similar: to describe the AGO through the 5 senses, and also in
a Dear Diary entry. It was going to be longer, but 3 words was all I needed.

My notes on the first day were to make “ART ABOUT ART” so I tried to use that as a
unifying principle for my proof-of-concepts.

PROJECT DIRECTION:

After chatting with peers in class, I’ve solidified the idea of creating a fancy coloring
book of abstract line drawings created using AGO architecture and patterns, in order to
relate and propagate the feelings the AGO and art provides—calmness, inspiration,
beauty, creativity—and carry the feelings to other people when they color. We joked that
it would be “Art Inception” because I use art (the architecture), to create art (photos),
which I turn into art (line drawings), and fill them in with art (patterns), in order to design
art (page layouts reminiscent of paintings on walls), to create a collection of art (the
book), so that people may color it in and create more art (their colored art)… all in the
spirit of art itself: inspiration and creativity! I’m really looking forward to this project. I
would like to use materials reminiscent of the AGO architecture and environment like
etched/cut-out wood or plexi for the book hardcover, and canvas-textured (or at least
something toothy) paper for the interior pages. I think it should be square or landscape
and smaller than 8.5x11in. I’m looking forward to some kind of silver binding, maybe
binder rings so the pages become removable?

OBSERVATION/SAMPLES/VISUALS/DOCUMENTATION OF SPACE:

#1. Printed material provided by the AGO. (3 items)

Art gallery map, entrance ticket, pamphlet.

#2. Audio. (5 minutes)

Museum white noise; mostly footsteps, light chatter, and floor squeaks.
[ It’s on my phone. I don’t know how to upload it anywhere else. Sorry… L I’ll solve this
problem if I decide to use it somehow next week. ]

#3. Video #1, a brief tour. (1:45 minutes)

Brief tour of main floor from entrance walking south to Grange House.
[ http://youtu.be/C2i3bOdB5Yk ]

#4. Video #2, of me walking. (6 minutes)

Video faces the floor, showing my feet as I walk over many different floor surfaces and
through different lighting conditions.
[ http://youtu.be/YK3r47fg_qM ]

#5. Photos of textures, materials, and patterns. (76)

#6. Photos of architecture and shapes. (79)

#7. Photos of art, far and near. (51)

#8. Drawing of relative sizes and placements of (almost all) paintings on the 2nd floor.

I wanted to introduce my own drawing so I made a “map” of hundreds of superimposed
rough square shapes—I drew the shape of all the paintings and how they were
positioned relative to each other or grouped together as I walked past all of them. This
method creates a dense texture or abstract art.

#9. Word map/List of single words describing the AGO.

I asked 80 museum patrons or staff to “describe the AGO in one word; anything you see
or feel, anything that pops into your mind”.
• smooth • apaisant • new • variety • huge • diverse • spacious • diverse • bright • vital •
inspirational • caramel • colorful • Canadian • beautiful • satisfied • pride • mystery •
artistic • variable • excellent • calming • imaginative • beautiful • unique • buenisimo •
calming • welcoming • great • beautiful • excellent • interesting • humbling • amazing •
eclectic • bangin’ • sleek • magical • bright • airy • inspiring • picturesque • calm • vibrant
• lost • intricate • lost • search • educational • eclectic • dazzling • necessary • excellent •
Canada • pretentious • Canadian • natural • Canadian • fantastic • serene • home •
inspiring • accessible • architectural • unexpected • excellent • outstanding • fabulous •
diverse • expanding • spacious • activities • eclectic • grand • color • color • inspiring •
vast • outstanding • impressive •

#10. 5 Senses word association.

taste --- fresh
sight --- space
touch --- culture
smell --- time
hearing --- footsteps

#11. Dear Diary… I think these words sum up my experience here best.

“I feel… calm. I hear… footsteps. I see… beauty.”

[ 10 ] [ 11 ]
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PROOF-OF-CONCEPTS:

#1. Advertisement mock-ups. (3 designs)

Advertisements for the AGO using the rectangle drawing, 
word map, and diary entry.

#2. Art about art. (3 paintings)

Miniature paintings using architecture photos representative 
of the AGO environment.

#3. Book of art (color). (3 pages)

I could make a book of my art based on AGO architecture, 
but I won’t. I want lines instead.

#4. Book of lines (b&w). (4 mock pages)

Book pages showing proportion of line art to be made using 
existing AGO art/architecture as inspiration. Instead of black 
and white I need to make line drawings…
lots and lots of line drawings.

I was also planning to make computer desktops/wallpaper, 
but decided it wasn’t the direction I wanted to go in. I also 
thought about doing mood boards since all the AGO colors 
and materials word so well together, but again, it’s not 
where I want to go with this project, so this week it’s a bit 
light on the proof-of-concepts. Line drawings coming
next week!!

WRITTEN COMPONENT—OBSERVATIONS:

SPACE /SPACE: There are many rooms, many corners, and hallways. I can use a map
to move from space to space.
SPACE /OBJECT: Space is organized by the genre of paintings and divided by walls.
Each room is then further organized by the placements of the art. In some rooms, there
are benches/chairs in the middle.
SPACE /ACT: People’s footsteps cut through space.
SPACE /ACTIVITY: People walk from room to room, from painting to painting.
SPACE /EVENT: When people stop to gaze at a painting, that space is now occupied
by a person. When a couple talk, most other people avoid the space where they chatter.
SPACE /TIME: The lighting from the vast windows at the front and back of the building
create different lighting conditions depending on the time of day.
SPACE /ACTOR: People are the main actors who move, pause, sit on benches, and
talk within the space.
SPACE /GOAL: People occupy the space in front of the painting they wish to look at.
SPACE /FEELINGS: Viewing paintings and art evokes emotional responses. Hallways
where people socialize more are more friendly environments.
OBJECT /SPACE: Lights on ceiling. Paintings on walls. Chairs/benches scattered along
hallway walls or in the middle of rooms with art.
OBJECT /OBJECT: Maybe if I take it one object at a time, but there are thousands of
paintings, so no.
OBJECT /ACT: Sometimes people sit up/down from chairs/benches. People with
glasses use them to look at pamphlets and paintings.
OBJECT /ACTIVITY: People rest on chairs/benches. I see one person on their laptop.
People take pictures with a phone/camera.
OBJECT /EVENT: People take pictures with phone/camera. Chair for sitting down.
OBJECT /TIME: At closing time, staff curtain off certain rooms with stanchions.
OBJECT /ACTOR: People use phones, cameras, wheelchairs, chairs, lights to see,
handrails, doors, stairs, elevators, etc.
OBJECT /GOAL: Maps are used to find specific rooms. Elevators and stairs to reach
new floors. Stanchions to get patrons to move in prescribed directions.
OBJECT /FEELINGS: Paintings= emotions, thoughts. Stanchions blocking a room I
want to enter= annoying. Chairs= relief for my feet. Curved stairs= J
ACT /SPACE: People walk on floor; watch paintings on walls; sit on chairs.
ACT /OBJECT: Talking on phone requires a phone. Walking requires shoes
(recommended). Girl needs hair-elastic to tie up hair.
ACT /ACT: Mostly people walking and looking. Some chatting if they come together.
ACT /ACTIVITY: Making steps is how people walk. Taking pictures is how people
record memories. Looking at a map is how to get un-lost. Reading is how you learn.
ACT /EVENT: Reading a descriptive plaque is part of understanding what a painting is
about. Act of sitting on floor may create the event of staff telling you to get up.
ACT /TIME: People walk faster when they are done with one room and ready for the
next. People enter when museum is open and leave when it closes.
ACT /ACTOR: Asking for directions involves people. Can’t see a painting without being
a living organism with eyes first.
ACT /GOAL: Walking reaches the goal of moving where you want to go. Asking for
directions begets directions.
ACT /FEELINGS: Well, I hope people are happy to be at the AGO and not walking
around against their will. Moving from painting to painting will change viewers feelings
based on each painting’s content/subject.
ACTIVITY /SPACE: Shopping happens in the shop. Workshops happen in the
basement rooms/area. Toilet usage happens in the washrooms. Ticket sales at front.
ACTIVITY /OBJECT: Bathroom visits involve toilets and mirrors. Viewing paintings
involves paintings to be seen.
ACTIVITY /ACT: Studying paintings involves reading and observing.
ACTIVITY /ACTIVITY: Not in detail because everyone is different, but the main activities
are walking and looking.
ACTIVITY /EVENT: Reading causes understanding. Walking causes arriving. Looking
at your watch/phone lets you know the time.
ACTIVITY /TIME: I think there are special days for children or tours which only happen
at specific times. Picking up your coat happens only when you want to leave. Visiting
the shop usually happens after visiting the museum, often at closing time.
ACTIVITY /ACTOR: Activity of viewing paintings requires humans (or intelligent life
capable of visiting the AGO).
ACTIVITY /GOAL: Activities are done in order to achieve goals. *headdesk*
ACTIVITY /FEELINGS: Museum-going, according to my research, causes inspiration,
happiness, and calmness.
EVENT /SPACE: Event of entering the building happens at the entrance. Same for
entering and exiting rooms which happens at doorways.
EVENT /OBJECT: Stopping to tie your shoe requires shoes. Checking the time requires
a phone or watch. Pausing in wonder at a painting requires the painting.
EVENT /ACT: Checking the time on your watch requires you to lift your arm.
EVENT /ACTIVITY: Moment of inspiration can happen from art study.
EVENT /EVENT: Can I describe the number of breaths people take?
EVENT /TIME: Art literacy happens after lots of observation and reading, not before.
EVENT /ACTOR: Without people, events would be left to nature.
EVENT /GOAL: Event of purchasing something from the museum shop fulfills goal of
buying souvenir.
EVENT /FEELINGS: Event of purchasing something from the museum shop should
make you happy, not sorry for having emptied your bank account.
TIME /SPACE: “Where do time periods occur?” is a strange question to me. There are
art movements/periods in human history that occur on Earth?
TIME /OBJECT: Time unfortunately ages and decays paintings, so we must take care of
them!! Time spent sitting is time not spent wearing out my shoes while walking.

TIME /ACT:
TIME /ACTIVITY:
TIME /EVENT:
TIME /TIME:
TIME /ACTOR:
TIME /GOAL:
TIME /FEELINGS:
ACTOR /SPACE:
ACTOR /OBJECT:
ACTOR /ACT:
ACTOR /ACTIVITY:
ACTOR /EVENT:
ACTOR /TIME:
ACTOR /ACTOR:
ACTOR /GOAL:
ACTOR /FEELINGS:
GOAL /SPACE:
GOAL /OBJECT:
GOAL /ACT:
GOAL /ACTIVITY:
GOAL /EVENT:
GOAL /TIME:
GOAL /ACTOR:
GOAL /GOAL:
GOAL /FEELINGS:
FEELINGS /SPACE:
FEELINGS /OBJECT:
FEELINGS /ACT:
FEELINGS /ACTIVITY:
FEELINGS /EVENT:
FEELINGS /TIME:
FEELINGS /ACTOR:
FEELINGS /GOAL:
FEELINGS /FEELINGS:

WRITTEN COMPONENT—IN ADDITION:

The AGO opening and closing times cannot be seen with the eye, but the time of day
affects how many patrons there are.
The age of the AGO cannot be seen. Years of wear, expansions, and renovations have
been covered by the latest version and I cannot see beneath the walls.
I cannot know who the architect(s) were—I only know one of them is Frank Gehry—
unless I see some written text about it.
I can’t know how the experience of being at the AGO affects individuals.
I can’t know the history of Grange House without researching it:

“The Grange was built about 1817 for lawyer and merchant D’Arcy Boulton jr. in an area
of exclusive residential estates in the town of York, now Toronto. One of the few such
houses to survive, its symmetrical 5-bay façade and central pediment reflect the
conservative influence of 18th century British classical tradition. The west wing
represents two later additions. One from the 1840s and the other built in 1885 for the
new owner, eminent public figure Goldwin Smith. In 1911, through the bequest of his
wife Harriet the house became the property of what is now the Art Gallery of Ontario.”

[ http://www.ago.net/grange-history ]
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TEXTURES,
MATERIALS,
PATTERNS

[ 19 ][ 18 ]



[ 21 ][ 20 ]



ARCHITEC-
TURE &
SHAPES
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ART,
NEAR & FAR

[ 29 ][ 28 ]



(That was 206 photos.)
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” Students must create ... distinct ways (ex. 

visceral [emotional over logical], conceptual 

[ideas about, not necessarily literal 

interpretations of], cultural [social behavior, 

rituals], functional [navigation, wayfinding, 

information] etc.) of communicating a space 

using materials and techniques to support intent. 

In class we will be discussing—and students will 

further explore— designers to consider their 

approach to making and/or thinking about 

their making. We do not look to others work to 

copy outcomes, but to study how a designer 

approaches the challenges/opportunities they 

faced in a given project.

Self-reflection: Identify one or two designers 

from the in class discussion (or that you have 

found on your own) for inspiration to generate 

this stage of the assignment. Identify the 

specific aspects of those works that inspired 

you (e.g., use of materials; use of elements and 

principles of design, etc.) and explain how and 

why. 

Students must employ a basic design vocabulary 

to speak and write clearly about their work.  

Demonstrate how basic concepts can inform and 

guide the development of a project. 

Demonstrate an ability to make and develop 

form across dimensions. 

Demonstrate an ability to manifest craft as a 

fundamental quality in all aspects of process and 

outcome. 
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PROGRESS/PLAN:

Last week I presented several proof-of-concept ideas: advertisement posters/concepts, painted acrylic
on canvas art, a rough book idea, and a line drawing idea. Unfortunately the best idea came last and I
wasn’t able to document much of it for last week’s PDF report. I was leaning towards making a book of
line drawings, and going forward in that direction, my plans for this project became pretty solid by the
end of last class. By the end of day, I had fleshed out most details in my head.

I will be creating a coloring book of line drawings filled in with line patterns, all inspired by the AGO. The
line drawings inside will be created using AGO architecture and patterns, 

(INTENT:) in order to relate
and propagate the feelings the AGO and art provides—calmness, inspiration, beauty, creativity—and
carry the feelings to other people when they color. 

Last week, we joked that it would be “Art Inception” because I use art (the architecture), to create art 
(photos), which I turn into art (line drawings), and fill them in with art (patterns), in order to design art 
(page layouts reminiscent of paintings on walls), to create a collection of art (the book), so that people 
may color it in and create more art (their colored art)… all in the spirit of art itself: inspiration and 
creativity! 

Because the plan is pretty solid, my “ways of communicating space” for this week will be centered on
the coloring book concept.

THIS WEEK:

This week a lot of my work is unfinished because after starting sketches for the line drawings, it became
obvious immediately there was no need. One drawing is enough for me to understand my way forward,
I don’t need to complete dozen(s), especially not in the wrong size.

I created the design for the coloring book’s Front Cover, Title Page, 2nd Title Page, and Back Cover. The
“white” pictured on the wood is going to be laser cut-out, that’s why the font has no counters, and I
continued that design to the title pages.

I drew potential layouts for 9 pages of the book.

I researched the prices, times, materials, and steps required to create the laser-cut book covers.

I researched Frank Gehry’s architecture; and inspirational line patterns that fit the AGO theme.

NEXT STEPS:

I’m going to use tracing paper to create all my 40+ 
(currently the plan is 45) line drawings/pages by hand. 
Because a coloring book needs actual pages, not just 5-10 
of them. I’ll do my best. Afterwards I’m likely not going to 
Illustrator the pages into vectors because that’s just way too 
much work. I will just scan and print, I think. I still need to 
work out what paper to use. If it’s bond paper, it’ll save me 
lots of time and money, but of course, that’s not as nice. I 
also need to find suitable binder rings for the binding, which 
seem to be more difficult to find than one would think. I 
researched what I need for wood and plexiglass covers but 
I’m keeping the options open for a few other materials I 
have in mind.
Lastly, depending on the cover material I end up choosing, 
that will determine how I punch the holes for the binding.

WAYS/ATTEMPTS:

1. Coloring book ---
cultural [social behaviour, rituals]: because adults enjoy coloring in coloring books to
relax these days.

The book is likely going to be between 5.5x5.5 to 7x7 inches in size. Square pages. Hard-covers made
from materials evocative of AGO architecture: wood, plexi, metal, and/or similar. Laser cut-out
letters on the front cover.
 

2. Page layout of book ---
visceral [emotional over logical]: because each page is a page, not a wall, but I’m
choosing to use odd, sometimes drastic shapes.

The placement of the line drawings will differ on each page; each page will be reminiscent of how
paintings hang in an art gallery: Each page will look like a wall with a painting on it. Creative freedom
will be used to create several unusual or oblique placements.

3. Line drawings ---
conceptual [ideas about, not necessarily literal interpretations of]: because I am not
recreating any paintings in my attempt to document the AGO, I’m looking at the
architecture, and translating that into abstract line drawings.

Line drawings for the coloring book will the created from several dozen photographs which capture
the flowing lines and smooth space of the AGO architecture best.

4. Patterns within line drawings ---
functional [navigation, wayfinding, information]: because complexity, richness, and
diversity of line is what sets adult coloring books apart from childrens’.

For additional visual interest and for more stimulating lines to color, any places within the line
drawings that are not dense enough with lines, will be filled in with additional line drawings; but this
time I’ll use patterns found in the AGO, and patterns I researched that evoke the mood of the AGO.

ADDITIONAL GATHERING:

The Art Gallery of Ontario is where I first experienced art as a child and it was Grange Park where I
played, so this project means a great deal to me. The building we envision will connect the city and its
people to great art and art experiences.
– Frank Gehry, Architect [ http://www.ago.net/about-frank-gehry ]

I chose to include this quote because as a Toronto native, I feel very similarly about the AGO and its
purpose. I hope my coloring book project can also “connect… people to great art and art experiences”.

http://www.ago.net/new-building
http://www.ago.net/frank-gehry-redesigned-ago
http://www.ago.net/fact-sheets

I read about a lot of the history of the AGO, and the Gehry expansion, which AGO debuted in 2008. Then
I searched for more of Frank Gehry’s architecture, which led me also to some of his furniture and hand
drawn sketches. I’m interested in channeling the way his lines converge and move.
Lastly, I looked for random line patterns to see what caught my eye.

I’ve included below a lot of saved pictures that I find inspirational in some way for this project.

WRITTEN COMPONENT—Self-Reflection:

I researched the architect Frank Gehry and looked at the way his lines move and converge. Like the AGO,
many of his other projects evoke calmness and monumentality at the same time as flowing serenity and
sleek sculptural lines. The quality of these lines which hold power in their simplicity is what I will try to
evoke in my coloring book line drawings. I also researched many patterns made of lines (from multiple
random designers), so that I can better integrate the kinds of surfaces the AGO has into the abstract line
drawings. For example, there were cut-out polkadot patterns on some of the walls, there was the layout
of the parquet and hardwood flooring, and many parallel lines on donation billboards. Adding these
patterns will “pre-color” the line drawings, making them more intricate to color, and therefore to enjoy.

WRITTEN COMPONENT—3 Ideas:

#1. TOPIC: AGO (2D&3D)

THEME: calmness, inspiration, beauty, creativity

CONCEPT: Create a coloring book of abstract line 
drawings filled in with line patterns, all inspired by 
the
AGO. “Art About Art”.

#2. TOPIC: AGO (2D)

THEME: learning, Canadian, community

CONCEPT: Create an advertizing campaign for the 
AGO based on the beautiful and inspirational words 
of
patrons and staff.

#3. TOPIC: AGO (2D?)

THEME: creativity, inspiration, translation

CONCEPT: Create a series of acrylic on canvas 
artworks which translate the artistic architecture of 
the
AGO into modern art. This will put focus on the art 
that is not on the walls, but is the walls.
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SAVED PICS 
OF THE AGO

SAVED PICS 
OF FRANK 

GEHRY 
ARCHITEC-

TURE
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SAVED PICS 
OF FRANK 

GEHRY 
FURNITURE

SAVED PICS 
OF FRANK 
GEHRY’S
SKETCHES

SAVED 
PICS OF 
PATTERNS
& LINES
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SELECTED PICS  
TO TURN INTO 

LINE DRAWINGS 
(from everything, narrowed down to 45)

(That was 94 pictures saved from the 
internet. Meaning, they are not mine.)
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”  Chose one direction from Stage 2 and further 

build and/or iterate based off in-class feedback 

and your own incubation over the last few weeks. 

2D can lend itself to quick variations (this image 

printed on this material versus that material, 

colour options, cropping, scale, etc) while 

motion and 3D can be intensive in other ways 

that are not as prolific. 

- Make as much as you can and document all 

your work. 

- Where possible show how you considered 

multiple options through making and not just 

words (you can have words of course, but if you 

think it, make it.)

Consider: scale is often left to the printer—8.5x11, 

11x17 etc. How can you use scale (or proportion 

when thinking about what the form will be in 

relationship to) to further communicate your 

ideas?

[ 65 ]



PROGRESS THIS WEEK:

This week I did a lot of things that can’t easily be seen, in 
preparation for the final stages.

I measured and cut paper.

I priced printing and paper options. Price will still be 
dreadfully high. :(

I went shopping for materials: binder rings (Staples), 
plexiglass (OCAD Plastics shop), canvas (Above Ground).

I looked at wood for the covers and once I saw it in person 
I changed to my Plan B cover material: Plexiglass. Once I 
saw the way the red industrial lettering on protective kraft 
paper ended up being positioned after cutting, I decided to 
leave it on and have the best of both worlds: initial brown/
organic color I wanted from the wood, and the hard smooth 
texture of the plexi. Plus the added bonus of having shiny 
see-through portions on the sides of the plexi.

During the phase I was going to use clear plexi covers 
I bought natural colored (off-white/sand color) canvas, 
the stiff kind used for painting, to use as an interior lining 
between the cover and title pages. It was supposed to add a 
natural element back into the design once I had eliminated 
the wood, and reiterate the “art” theme.

I folded temporary covers of 5.5x5.5, 6.6, 6.5x6.5, and 7x7 
inches in order to decide on the book size.

Once settled on the 6.5x6.5 size, I punched a lot of holes 
and carefully measured to create the right about of space 
between the covers—important because since the binding 
is binder rings, not a traditional stitched or glued binding, 
covers will move vertically and independently of each other.

Carefully created the Illustrator file for the covers to be cut. 
Then went and cut the covers at OCAD’s “Rapid Prototyping 
Center”. Wooo!!! :)

Balance between type size, placements between punch-
holes, and borders were important. Lastly, I made one 
tracing as a test to test techniques and pen, speed, etc. 
………………..but I’m not really pleased. I’ll have to fix the line 
quality somehow.

WRITTEN COMPONENT—Denotative Description:

Two hard plexiglass sheets, 1/8th inch thick, 6.5x6.5 inches per sheet.
Square shape.
Geometric typeface.
Plexiglass coated in kraft paper with red color writing.
Cut-out title letters.
Shiny silver binder rings, 1-inch diameter.
Light shimmers through plexiglass sides.
72pt geometric sans-serif typeface (Gotham) with no counters.
Rings go through holes in plexiglass, 3 on each sheet.
Connected sheets, can move.
Smooth texture.
Straight lines, right angles.
Asymmetrical type layout, flush left. Dense in a upper-right corner.
Red text on outside covers contrast with clean kraft inside covers.
Materials contrasted/juxtaposed: clear plastic/ opaque brown kraft paper/ silver metal.
Shape contrast: square covers/round bindings.
3 Binding holes align in vertical line, repeated, same round shape&size hole.
No gradation or photos, only solid colors or textures.
Transparency peek-a-boo on sides of plexiglass—reflect light.
Consistent alignment of the words “ART” with punch hole at left.
Red color disrupts kraft colored space—adds unexpected elements.
Asymmetrical placement and alignment of red color elements.
Letters extracted from cover.
Density only in areas with writing. Overall sparse layout.
3D design.
Hard materials.
Extruded letters.
Word “ART” is twice in title—repetition.
Mirrored covers because both are square shapes bound in middle.
Horizontal and vertical directions because there are no diagonal elements to the design (except in the letterforms).

WRITTEN COMPONENT—3 Details & Connotation:

#1. 3-Dimensional design:

Architectural. Innovative. Unusual. Industrial. Tough.

#2. Smooth textures:

Clean. Sleek. Modern. Minimalist.

#3. Geometric shapes:

Basic. Solid. Unadorned. Stable. Mathematical. Approachable.
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The Rapid Prototyping Centre has two Techno ISEL computer numerically controlled (CNC) Routers.  Access to the CNC 
routers is open to all students and faculty of OCAD U for academic based projects only.

Cost
The cost to use the CNC router is $20 per hour, with a minimum charge of one hour. There is a $6 file set up fee which 
includes the review of your file and the set up on the CNC bed.  There will be an additional $5 fee for every sheet of ma-
terial beyond the first sheet.

Overview
The CNC router can be used for cutting 2d part files and 3d surfacing. The CNC router has a 4’x8’ bed with a 4”gantry 
clearance (Z height).  For 2d cutting, there should be a 1” margin no cut zone around the perimeter of your material stock 
to screw into the router spoil board. The router is a 3-axis router, therefore it cannot make undercuts and bevel cuts.

Materials you can use are:
Wood, including plywood and hardwood 
Rigid Insulation Foam
Plastics, such as acrylic and polyethylene (LDPE / HDPE)

Preparing Your Files For CNC
There are a few steps involved in preparing your files for the CNC router. 

The first step involves preparing your part geometry. This can be done in any software program (Rhino, 3dsMax, Maya, 
Solidworks, Sketch-Up). 2D cutting requires only 2d line drawings.  Software programs AutoCad and Illustrator can be 
used to generate 2D line drawing files. 2d cut parts should have all parts joined as a closed vector geometry. Be sure your 
lines meet exactly at endpoints, and there are no duplicate, intersection, or overlapping lines. 3d surfacing uses a surface 
or solid model. These files should be at actual scale of the part you are making.

Tool-paths need to be generated to program the machine to cut your part. We use VisualCAM Import file types: DWG is 
recommended for 2d files, and STL for 3d surfaces. The three basic operations of VisualCAM are profiling (cutting), hori-
zontal roughing (rough cutting of surfaces), and parallel finishing (finish cutting of 3d surfaces). 

Cutter Information
To improve cut quality We recommend purchasing your own cutter.  Available collet sizes are 1/8”, 1/4”, 3/8” and 1/2”.  
To determine the best type of cutter for your project, speak to the technician.  
If you do not provide your own cutter, a $25 cutter fee will be charged for the use of our stock cutters.  

Before your part can be milled, you need to review your file with the technician. The technician will quickly preview your 
file for errors and correct settings. Do not expect that this part can be run immediately. There is a 3 day lead time for the 
CNC router.

Material Preparation
Students must supply their own materials. If your material stock is glued up, be sure that it has had at least 24 hours to 
dry. Use liberal amounts of glue spread evenly across the material to ensure complete adhesion when laminating materi-
als. Please ensure the material is cut square and true.  Also please note your actual material thickness, as this may effect 
your VisualCAM settings. Use calipers to get the exact thickness of your material. For example, if using ¾” plywood, it is 
likely the actual thickness is .6875”. This information is important when designing your file.

Questions
If you have questions about the CNC router, please drop by the Rapid Prototyping Centre (Room 130) and speak to the 
technician.

Rapid Prototyping Centre 

Ho
w

 to
 se

t u
p 

a 
fil

e 
in

 A
do

be
 Il

lu
st

ra
to

r C
S

W
e 

re
co

m
m

en
d 

do
w

nl
oa

di
ng

 o
ur

 d
ra

w
in

g 
te

m
pl

at
es

.  
Te

m
pl

at
es

 fo
r A

do
be

 Il
lu

st
ra

to
r c

an
 b

e 
do

w
nl

oa
de

d 
he

re
.  

Th
e 

“A
rt

 b
oa

rd
” 

siz
e 

of
 th

e 
te

m
pl

at
e 

is 
se

t t
o 

48
”x

 2
7”

. T
hi

s i
s t

he
 si

ze
 o

f t
he

 la
se

r b
ed

. A
ny

th
in

g 
la

rg
er

 th
an

 4
8”

x 
27

”w
ill

 
no

t fi
t o

n 
th

e 
la

se
r a

nd
 th

er
ef

or
e 

w
ill

 n
ot

 b
e 

ac
ce

pt
ed

.

•S
et

 a
rt

 b
oa

rd
 to

 m
at

ch
 th

e 
siz

e 
of

 y
ou

r m
at

er
ia

l i
n 

in
ch

es
Go

 to
 F

ile
 ->

 D
oc

um
en

t S
et

up
 ->

 E
di

t A
rt

bo
ar

ds
 ->

 S
et

 w
id

th
/h

ei
gh

t o
f y

ou
r m

at
er

ia
l.

If 
yo

u 
ar

e 
no

t u
si

ng
 th

e 
te

m
pl

at
e 

pr
ov

id
ed

•M
ak

e 
su

re
 y

ou
 a

re
 w

or
ki

ng
 in

 in
ch

es
  

Se
le

ct
 F

ile
 ->

 D
oc

um
en

t S
et

up
 ->

 U
ni

ts
 ->

 In
ch

es

•S
et

 a
rt

 b
oa

rd
 to

 m
at

ch
 th

e 
siz

e 
of

 y
ou

r m
at

er
ia

ls 
Se

le
ct

 F
ile

 ->
N

ew
 ->

 S
et

 w
id

th
/h

ei
gh

t f
ro

m
 th

e 
m

en
u

Ra
pi

d 
Pr

ot
ot

yp
in

g 
Ce

nt
re

•M
ak

e 
su

re
 y

ou
 a

re
 w

or
ki

ng
 in

 R
GB

 m
od

e 
Se

le
ct

 F
ile

 ->
Do

cu
m

en
t C

ol
ou

r M
od

e 
->

 R
G

B
La

se
r C

utti
ng

/E
ng

ra
vi

ng
 L

in
es

Th
e 

pr
e-

se
le

ct
ed

 c
ol

ou
r g

ro
up

: T
he

se
 c

ol
ou

rs
 a

re
 th

e 
fo

ur
 c

ol
ou

r o
pti

on
s f

or
 la

se
r c

utti
ng

. T
he

se
 a

re
 th

e 
on

ly
 c

ol
ou

rs
 th

at
 

th
e 

la
se

r w
ill

 re
co

gn
ize

. 

U
se

 B
la

ck
 (R

G
B:

 0
,0

,0
) f

or
 e

ve
ry

th
in

g 
yo

u 
w

ou
ld

 li
ke

 e
ng

ra
ve

d.
 Th

e 
la

se
r c

ut
s t

he
 c

ol
ou

rs
 in

 o
rd

er
. S

ta
rti

ng
 w

ith
 R

ed
 (R

G
B:

 2
55

, 0
, 0

) f
ol

lo
w

ed
 b

y 
Bl

ue
 (R

G
B 

0,
0,

25
5)

, a
nd

 fi
na

lly
 G

re
en

 
(R

G
B 

0,
25

5,
0)

. A
ll 

in
te

rio
r c

ut
s s

ho
ul

d 
be

 c
ut

 fi
rs

t a
nd

 th
er

ef
or

e 
sh

ou
ld

 b
e 

re
d,

 w
ith

 a
ny

 fu
rt

he
r c

ut
s b

ei
ng

 B
lu

e,
 a

nd
 th

e 
fin

al
 e

xt
er

io
r c

ut
s b

ei
ng

 G
re

en
.

Al
l l

as
er

 c
ut

s a
nd

 e
ng

ra
ve

 li
ne

s s
ho

ul
d 

ha
ve

 a
 st

ro
ke

 w
ei

gh
t o

f 0
.0

1p
t

• 
M

ak
e 

su
re

 y
ou

 p
ul

l u
p 

th
e 

Ba
sic

 R
GB

 c
ol

ou
r s

w
at

ch
Se

le
ct

 S
w

at
ch

 L
ib

ra
ry

 M
en

u 
->

 D
ef

au
lt 

Sw
at

ch
es

 ->
 B

as
ic

 R
G

B 

Ra
st

er
 L

in
es

 a
nd

 F
ill

s

Al
l v

ec
to

rs
 y

ou
 w

ou
ld

 li
ke

 ra
st

er
 e

ng
ra

ve
d 

m
us

t b
e 

in
di

ca
te

d 
by

 a
 v

ec
to

r fi
ll.

Se
t a

ll 
fil

l c
ol

ou
rs

 to
:

Bl
ac

k:
 R

G
B:

 0
,0

,0

Th
e 

Ra
st

er
in

g 
Eff

ec
t i

s a
ch

ie
ve

d 
by

 le
av

in
g 

yo
ur

 p
at

hs
 fi

lle
d 

w
ith

 b
la

ck
. H

ow
ev

er
, d

iff
er

en
t d

ep
th

s o
f r

as
te

rin
g 

ca
n 

be
 

ac
hi

ev
ed

 b
y 

us
in

g 
se

ve
ra

l t
on

es
 o

f g
re

y.
 B

la
ck

 w
ill

 a
lw

ay
s b

e 
ra

st
er

ed
 th

e 
de

ep
es

t, 
w

ith
 W

hi
te

 n
ot

 b
ei

ng
 to

uc
he

d.
 T

he
 

da
rk

ne
ss

 o
f t

he
 G

re
y 

to
ne

 w
ill

 d
et

er
m

in
e 

ho
w

 d
ee

p 
th

e 
ra

st
er

 w
ill

 b
e.

 H
ow

ev
er

 to
 a

ch
ie

ve
 th

e 
ra

st
er

in
g 

eff
ec

t, 
th

e 
la

se
r 

pa
ss

es
 o

ve
r a

n 
ob

je
ct

 h
un

dr
ed

s o
f ti

m
es

 re
m

ov
in

g 
on

e 
be

am
 w

id
th

 p
er

 p
as

s.
 T

hi
s m

ea
ns

 v
er

y 
la

rg
e 

ra
st

er
in

g 
jo

bs
 c

an
 g

et
 

ve
ry

 e
xp

en
siv

e.
 S

o 
us

e 
th

is 
te

ch
ni

qu
e 

w
ise

ly.

ex
am

pl
e 

of
 la

se
r 

ra
st

er
in

g,
 e

ng
ra

vi
ng

 a
nd

 c
ut

ti
ng

•Make sure you are working in RGB mode 
Select File ->Document Colour Mode -> RGB

Laser Cutting/Engraving Lines

The pre-selected colour group: These colours are the four colour options for laser cutting. These are the only colours that 
the laser will recognize. 

Use Black (RGB: 0,0,0) for everything you would like engraved.
 
The laser cuts the colours in order. Starting with Red (RGB: 255, 0, 0) followed by Blue (RGB 0,0,255), and finally Green 
(RGB 0,255,0). All interior cuts should be cut first and therefore should be red, with any further cuts being Blue, and the 
final exterior cuts being Green.

All laser cuts and engrave lines should have a stroke weight of 0.01pt

• Make sure you pull up the Basic RGB colour swatch
Select Swatch Library Menu -> Default Swatches -> Basic RGB 

Raster Lines and Fills

All vectors you would like raster engraved must be indicated by a vector fill.

Set all fill colours to:
Black: RGB: 0,0,0

The Rastering Effect is achieved by leaving your paths filled with black. However, different depths of rastering can be 
achieved by using several tones of grey. Black will always be rastered the deepest, with White not being touched. The 
darkness of the Grey tone will determine how deep the raster will be. However to achieve the rastering effect, the laser 
passes over an object hundreds of times removing one beam width per pass. This means very large rastering jobs can get 
very expensive. So use this technique wisely.

example of laser rastering, engraving and cuttingMinimum Cut Widths

Nesting:
If compiling a file with lots of components on one sheet of material, make sure there is a gap of at least 5/64” 
or 2mm between the components.

Small details / cut widths:
We recommend that minimum cut widths be no smaller than 1/16”  We can go smaller but things can get quite 
fragile and we cannot guarantee it will work.

Materials

The laser cutter can cut/engrave an abundance of materials including:
Acrylic, Abs, Acetal, Styrene, Polypropylene, Zotefoam, Solid Wood, Veneered MDF, Plywood, Paper & Card 
stock, Fabric and Rubber.

We do not cut materials that are thicker 1/4” with some exception.

Maintaining continuous vector geometry

Make sure that all your vector paths are continuous. If strokes / closed shapes are constructed from more than one path, 
make sure that you join / close the paths.

To do this, use the Direct Selection Tool and select the open endpoints.
Select Object > Path > Join (Ctrl+J) from the top menu

Using Text

All text used needs to be Outlined / converted to paths.

Select Type > Font > Create outlines from the top menu

This step converts the text to vectors and preserve your font. If you don’t do this and we don’t have your font installed 
on our computers, the file will open in default font Myriad or Arial. 

Using a stencil font can prevent the middle islands of some letters to fall out when laser cut, making the word difficult to 
read. 

Saving your file

Select File > Save As
File Format Adobe Illustrator .ai

IMPORTANT
This allows us to open the file in illustrator and make any neccesary edits to your laser file.  Please note there is a mini-
mum 24 hour lead time.
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” Revise work from Stage 3 based off in-class 

feedback and compile your work for final 

critique.

A) Extensively document your outcome for this 

project. Capture at least 25 images of the details 

of your project for your process submission and 

for your process book. This can be displayed 

digitally for the critique. Thoughtfully consider 

your elements, principles, and actions when 

generating your imagery. 

B) You will need to compile a complete process 

book documenting your entire four weeks. 

Bring your outcome of the project to present to 

the class.

[ 77 ]



THIS WEEK:

This week I had to draw all the line drawings. I thought it 
would be the longest part of the work but I was wrong. 
After testing a million black pens so that I could trace 
directly on my laptop screen—because on tracing paper a 
black pen is not just a black pen—I finally picked one. And 
then the tracing and drawing happened, with lots of added 
creative embellishments. I ended up making 23 drawings, 
even though I had planned to do more, these took almost 
a whole day. Then I scanned the 23 and spent another day 
Photoshopping out artifacts, small blemishes, and fixing 
sloppy lines. It took so long, and the drawings still look 
worse than they should. I didn’t expect to have to correct so 
many of my poorly-drawn lines. If I were to do this project 
over with unlimited time, I would have Illustratored the 
line drawings from scratch so that I could have vector files 
instead. I tried Image-Tracing my drawings but it was a 
disaster no matter what setting I used. 

Then I laid out the book in InDesign, and finally printed 
my first draft. Even though I didn’t see any artifacts on 
the computer screen, on bond paper fuzzy gray areas got 
printed instead of pure white. I went back and fixed all 
23 images, printed again and to my great displeasure the 
second time there was less gray but still gray artifacting, 
even though the contrast was turned way up and any 
further would have affected the line quality. I was pretty 
upset about that, and even more distraught when I didn’t 
make it to the printer before Friday at 5PM when it closes. 
I considered backing each 20lb bond paper page with 
110lb black card but scrapped the idea because it was too 
thick, also glue= bad idea.  I was so close to ending up with 
bond paper pages but at the super last minute I decided to 
bite the bullet and spend $20+ on printing on nice matte 
100lb paper. So even though the drawings aren’t perfect, 
in the end the $40 total on this project was totally worth it 
because this book is awesome!!!  :) 

There were a couple accidents along the way, like when I 
hole-punched a bunch of pages on the wrong side because 
I was falling asleep; and some low moments in my esteem 
while creating this book. Like, there was a moment I 
considered last minute to change the size of the book, to 
5.5x5.5 inches, that way I could fold 8.5x11 pages in two and 
make a much more economical book. I actually considered 
this heavily from the beginning, because I could do soft-
covers; but I think that’s a bit small for a coloring book, and 
it would also be a different size than my plexiglass covers… 
so no. Maybe I’ll make a smaller cheap version in my free 
time though.

I actually took 618 pictures of the book back when I thought 
I would leave the book with bond paper pages. I took the 
pics in the bathtub because bathtubs make great lightboxes. 
Thankfully I got a new phone this week otherwise my 
old phone would have died by the 5th picture. The more 
pictures I took the more creative I became with the lighting 
and angles. I started with normal 4:3 size, and quickly 
changed to square pictures because 1:1 matches the book 
design. This was great practice to know what looks good, 
so I re-did the photo session again when I changed out the 
inside pages to the better paper. I took 244 photos of the 
final product. I included 27 copies of my fav pics at the end, 
at 800x800px size (the originals are 3024x3024px).

In conclusion, I’m happy with this project. I think I met my 
objective really well. I hope to find a way to actually get the 
AGO to sell a version of my book in their gift shop—maybe? 
I can dream. :)  
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618 Pictures 
taken in a bathtub.
... The first time.
This was practice using the “almost done” book.

ART ABOUT ART IS A COLORING BOOK.

THE LINE DRAWINGS ARE DRAWN BY EMA DAN.

SHE WAS INSPIRED BY THE ARCHITECTURE AND MATERIALS AT THE 

 ART GALLERY OF ONTARIO, IN TORONTO, CANADA.

EMA SUGGESTS THAT YOU USE A LIMITED COLOR PALETTE WHEN COLORING IN THIS BOOK.

THEN YOU MAY TAKE THE PAGES OUT AND DISPLAY THEM SOMEWHERE. 

 OR NOT. IT’S UP TO YOU.

THE PURPOSE OF THIS BOOK IS TO PASS ON TO OTHERS THE CALM FEELING AND CREATIVE 

 ENERGY THAT ONE FEELS AT THE AGO.

EMA PRINTED THIS BOOK AT THE OCADU PRINT SHOP AND CUT THE PAGES HERSELF.

THE COVERS WERE LASER CUT AT THE RAPID PROTOTYPING CENTER AT OCAD UNIVERSITY.
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Can I just say that bathtubs make *fantastic* light-boxes??

Ok. Now the final pictures. 
225 of them. :)
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THE END.
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